This document supports the version of each product listed and supports all subsequent versions until the document is replaced by a new edition. To check for more recent editions of this document, see http://www.vmware.com/support/pubs.
You can find the most up-to-date technical documentation on the VMware Web site at:

http://www.vmware.com/support/

The VMware Web site also provides the latest product updates.

If you have comments about this documentation, submit your feedback to:

docfeedback@vmware.com
Contents

VMware Horizon FLEX Administration Guide 5

1 Introducing Horizon FLEX 7
   Horizon FLEX Components 7
   About Mirage 8
   Horizon FLEX Architecture 8
   Horizon FLEX System Requirements 10
   Horizon FLEX Server System Requirements 10
   Horizon FLEX Network Requirements 11
   Supported Host and Guest Operating Systems 12

2 Installing Horizon FLEX 13
   Horizon FLEX Installation Overview 13
   Installing and Configuring Mirage Components for Horizon FLEX 14
   Create a Download Folder for Horizon FLEX Virtual Machine Packages 15
   Set Up a Certificate for the Horizon FLEX Server by Using OpenSSL 15
   Configure the IIS SSL Server Certificate for the Horizon FLEX Server 16
   Configure Active Directory Settings 16
   Test the Horizon FLEX Admin Console Connection 17
   Installing the Horizon FLEX Client for End Users 18
      Create a Mass Deployment Package to Install Fusion Pro 18
      Provide a Workstation Player Installation Package to End Users 18
      Run an Unattended Workstation Player Installation 19

3 Setting Up Certificates for Horizon FLEX Virtual Machines 21
   Creating a Trusted Certificates List 21
      About the PEM Format 22
      Creating PEM-Format Certificates 22
      Create and Import the Trusted Certificates List File 23
      Updating Certificates on the Server 24
   Using Self-Signed Certificates 24
      Install a Self-Signed Certificate on a Windows Computer 24
      Install a Self-Signed Certificate on a Mac 25
   Using Internal CA Certificates 27
      Install an Internal Root CA Certificate on a Windows Computer 27
      Install an Internal Root CA Certificate on a Mac 28

4 Creating and Deploying Horizon FLEX Virtual Machines 31
   Horizon FLEX Virtual Machine Deployment Overview 31
   Create a Source Virtual Machine in Fusion Pro 32
   Create a Source Virtual Machine in Workstation Pro (Not included in Horizon FLEX) 33
Install the Mirage Client In a Source Virtual Machine 35
Prepare a Source Virtual Machine to Join an Active Directory Domain 36
Compress a Source Virtual Machine Package 37
Register a Source Virtual Machine with the Horizon FLEX Policy Server 37
Creating Policies and Entitlements 38
  Configure a General Policy for a Horizon FLEX Image 39
  Configure a USB Device Policy for a Horizon FLEX Image 40
  Configure a Custom USB Device Policy for a Horizon FLEX Image 41
  Update a Policy for a Deployed Horizon FLEX Image 42
  Entitle a Horizon FLEX Image 43
  Create a Virtual Machine Name Pattern 45
Create a URI to Deploy a Horizon FLEX Virtual Machine 46

5 Managing Horizon FLEX Virtual Machines 47
  Manage Horizon FLEX Virtual Machines 47

6 Maintaining the Horizon FLEX System 49
  Upgrade from Previous Horizon FLEX Versions 49
  Horizon FLEX System Logs 50

Index 51
The VMware Horizon FLEX Administration Guide describes how to install and administer VMware Horizon FLEX™.

Intended Audience

This information is intended for anyone who wants to install Horizon FLEX. The information is written for experienced Windows system administrators who are familiar with virtual machine technology.
Introducing Horizon FLEX

Horizon FLEX is a policy-based, containerized desktop solution that enables IT administrators to create, secure, and manage local desktops for end users. End users work within a restricted virtual machine, called a Horizon FLEX virtual machine, on their own computers. Because Horizon FLEX virtual machines are stored locally, on end-user computers, corporate applications are accessible to offline users.

This chapter includes the following topics:

- “Horizon FLEX Components,” on page 7
- “Horizon FLEX Architecture,” on page 8
- “Horizon FLEX System Requirements,” on page 10
- “Horizon FLEX Server System Requirements,” on page 10
- “Horizon FLEX Network Requirements,” on page 11
- “Supported Host and Guest Operating Systems,” on page 12

Horizon FLEX Components

Horizon FLEX is a combination of VMware components, including Mirage, Fusion Pro, and Workstation Player.

<table>
<thead>
<tr>
<th>VMware Mirage® for Horizon FLEX</th>
<th>The Mirage Server that is used by Horizon FLEX. The server provides Horizon FLEX virtual machine management. You can manage, back up, and patch virtual machines by using the Mirage for Horizon FLEX layering technology. Use of Mirage for Horizon FLEX is optional. You can also use other image management tools to manage Horizon FLEX virtual machines.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Horizon FLEX Policy Server</td>
<td>The standard Mirage server with an extension that includes Horizon FLEX-specific functionality. The Horizon FLEX Policy Server is activated after you apply the Horizon FLEX license to Mirage for Horizon FLEX.</td>
</tr>
<tr>
<td>Horizon FLEX Admin Console</td>
<td>The Web management user interface for the Horizon FLEX Policy Server. The Horizon FLEX Admin Console is located in the Mirage Web Manager component. You use the Horizon FLEX Admin Console to perform virtual machine management tasks, including the following:</td>
</tr>
<tr>
<td></td>
<td>- Manage an inventory of virtual machines</td>
</tr>
<tr>
<td></td>
<td>- Browse a list of users and groups in the Active Directory service</td>
</tr>
<tr>
<td></td>
<td>- Entitle users and groups to one or more virtual machines</td>
</tr>
<tr>
<td></td>
<td>- Specify virtual machine policies for a given entitlement</td>
</tr>
</tbody>
</table>
- Prevent users from accessing virtual machines by using remote lock
- Examine virtual machine details and status at any time

**Horizon FLEX Client**
The client software that end users use to download the Horizon FLEX virtual machines to their local computers. The clients include VMware Fusion Pro® Pro for Mac computers and VMware Workstation Player™ for Windows computers. Fusion Pro and Workstation Player are included in the Horizon FLEX package. One license key is provided for both Fusion Pro and Workstation Player.

**Horizon FLEX Virtual Machine**
The virtual machine that end users run on their own computers. You use Fusion Pro to create source virtual machines for Horizon FLEX virtual machines. Fusion Pro is included in the Horizon FLEX package. A Horizon FLEX server can support up to 1,000 users.

**Note** You can also use VMware Workstation Pro™ to create source virtual machines. Workstation Pro is not included in the Horizon FLEX package.

**About Mirage**
Mirage is integral to the operation and use of Horizon FLEX virtual machines.
Horizon FLEX uses a subset of the features available in Mirage:
- Mirage Server
  - Mirage Management Server
- Mirage Web Manager
  - Mirage Management Console

This document does not describe all of the information pertaining to Mirage. For complete information about Mirage, see the Mirage documentation at [https://www.vmware.com/support/pubs/mirage_pubs.html](https://www.vmware.com/support/pubs/mirage_pubs.html).

**Horizon FLEX Architecture**
A typical Horizon FLEX deployment includes the Horizon FLEX server, a file server, an HTTPS proxy, a read-only domain controller (RODC), and offsite and onsite end-user systems.

**Figure 1-1** shows the relationships between the major components of a Horizon FLEX deployment.
Horizon FLEX Server

The Horizon FLEX server is composed of the Horizon FLEX Admin Console and the Horizon FLEX Policy Server. The Horizon FLEX server provides the following functionality.

- Assigns Horizon FLEX virtual machines to users and groups from a directory service
- Maintains a record of Horizon FLEX virtual machines in use by individual users
- Provides security certificate management to ensure the secure and trusted communication between the deployed Horizon FLEX virtual machines and the Horizon FLEX server.
- Enforces policy settings to the client
- Enables modification of policy settings for a given user and Horizon FLEX virtual machine combination
- Monitors Horizon FLEX virtual machine status

The Mirage Management Console is the graphical user interface used for scalable maintenance, management, and monitoring of deployed endpoints. The Mirage Web Manager mirrors Mirage Management Console functionality.

By default, port 7443 is used by the Horizon FLEX Policy Server for external access, and port 8443 is used by the Mirage Management Server to communicate with the Horizon FLEX Policy Server. You must configure your firewall policies to allow the required ports. For a complete list of ports used by Mirage, see the Mirage documentation at https://www.vmware.com/support/pubs/mirage_pubs.html.

File Server

A file server stores the TAR files that contain the source virtual machine files for Horizon FLEX virtual machines. The file server can be on any server that a client user can access without entering credentials. The file server is located inside the DMZ in this example but that is not required.
**HTTPS Proxy**
An HTTPS proxy enables offsite end-user systems to reach the Mirage Management Console and get policy updates.

**RODC**
An RODC enables office end-user systems to log in to their Horizon FLEX virtual machines and join the Active Directory domain for the first boot up of the VM. An RODC is required only if you are allowing outside users to log in without using a VPN. The RODC is inside the DMZ.

**Load Balancing**
Horizon FLEX supports load balancing using multiple policy servers. Set up an active/passive Windows server set for fault tolerance for your Horizon FLEX topology.

**Horizon FLEX System Requirements**
Each product in the Horizon FLEX package has certain system requirements.

<table>
<thead>
<tr>
<th>Product</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Horizon FLEX Server and Mirage Server Requirements</td>
<td>For more information, see “Horizon FLEX Server System Requirements,” on page 10.</td>
</tr>
<tr>
<td>Mirage for Horizon FLEX</td>
<td>The system requirements for Horizon FLEX 1.6 are the same as for Mirage 5.5. See the Mirage documentation at <a href="https://www.vmware.com/support/pubs/mirage_pubs.html">https://www.vmware.com/support/pubs/mirage_pubs.html</a>.</td>
</tr>
<tr>
<td>Horizon FLEX Client for Mac</td>
<td>Horizon FLEX 1.6 uses Fusion Pro 8.0 as the client software for Mac clients. Horizon FLEX 1.6 is not compatible with earlier versions of Fusion Pro. For Fusion Pro hardware and software requirements, see the VMware Horizon FLEX Client User Guide.</td>
</tr>
<tr>
<td>Horizon FLEX Client for Windows</td>
<td>Horizon FLEX 1.6 uses Workstation Player 12.0 as the client software for Windows clients. Horizon FLEX 1.6 is not compatible with earlier versions of Player Pro. For Workstation Player hardware and software requirements, see the VMware Horizon FLEX Client User Guide.</td>
</tr>
<tr>
<td>Workstation Pro</td>
<td>You can use Workstation Pro 12.0 to create and open a source virtual machine, but Workstation Pro cannot download a Horizon FLEX virtual machine. Workstation Pro is not included in the Horizon FLEX installation package. For Workstation Pro hardware and software requirements, see the Workstation Pro documentation at <a href="https://www.vmware.com/support/pubs/ws_pubs.html">https://www.vmware.com/support/pubs/ws_pubs.html</a>.</td>
</tr>
</tbody>
</table>

**Horizon FLEX Server System Requirements**
The Horizon FLEX environment includes system requirements for both the Horizon FLEX server and the Mirage server.

**Horizon FLEX Server System Requirements**
- Minimum CPU: 1 Quad-Core Processor or 2 vCPU
2.26 GHz Intel core speed or equivalent
Minimum RAM: 512 MB with 4 GB recommended
Minimum disk space: 10 GB+, 40 GB+ recommended
Windows 2008 R2, Windows 2012 or later
.NET 4.5.1 and later
IIS 7.0+ with IIS Management Compatibility, with ASP and ASP.NET
Active Directory: Administrator account with permissions to add computer objects to the domain
SQL 2008 Express or SQL Server 2008 (required for Mirage installation)
HTTP file share or IIS virtual directory with available space for source virtual machines
Firewall ports for the Horizon FLEX Admin Console
- IIS and Horizon FLEX Web App default ports: HTTP - 7080, HTTPS - 7443 (Calls directed to the HTTP port are redirected to the HTTPS port.)
- Mirage Management Server listens to Windows Communication Foundation (WCF) requests on the following port: HTTP - 8443
A certificate is required for the Horizon FLEX Server if using SSL.

Mirage Server Requirements
- Minimum CPU: 4 vCPU with 8 vCPU recommended
- Minimum RAM: 8 GB with 16 GB recommended
- 146 GB free disk space
- Windows 2008 R2, Windows 2012 or later
- .NET 4.5.1 and later

Horizon FLEX Network Requirements
Horizon FLEX enables end users to run corporate applications even when they are disconnected from the network. Horizon FLEX virtual machines are stored locally for a complete desktop experience that does not require a network connection.

A network connection is required between the Horizon FLEX Policy Server and the Horizon FLEX Client in the following circumstances:
- For the initial download of the Horizon FLEX virtual machine to the user’s local computer.
- To register a Horizon FLEX virtual machine that was provided on a USB device or deployed on the user’s local computer.
- To receive Horizon FLEX virtual machine restriction and policy updates.

When you register a source virtual machine for a Horizon FLEX virtual machine, you specify a download location URL for virtual machine package. The download folder must be accessible to end user computers for end users to download virtual machines.
Supported Host and Guest Operating Systems

The local computer on which end users use the Horizon FLEX Client must have a supported host operating system. A Horizon FLEX virtual machine must use a supported guest operating system.

Supported Host Operating Systems

Your end users can run the Horizon FLEX Client and access their Horizon FLEX virtual machine by using a physical computer that has one of the following operating systems.

Table 1-1. Supported Host Operating Systems

<table>
<thead>
<tr>
<th>Horizon FLEX Client</th>
<th>Supported Operating Systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workstation Player</td>
<td>Windows 7</td>
</tr>
<tr>
<td></td>
<td>Windows 8.1 Enterprise</td>
</tr>
<tr>
<td></td>
<td>Windows Server 2012 R2</td>
</tr>
<tr>
<td></td>
<td>Windows 8</td>
</tr>
<tr>
<td></td>
<td>Windows 8.1 Pro</td>
</tr>
<tr>
<td></td>
<td>Windows 10</td>
</tr>
<tr>
<td><strong>Note</strong> Workstation Player supports only 64-bit operating systems.</td>
<td></td>
</tr>
<tr>
<td>Fusion Pro</td>
<td>Mac OS X 10.11</td>
</tr>
<tr>
<td></td>
<td>Mac OS X 10.10</td>
</tr>
<tr>
<td></td>
<td>Mac OS X 10.9</td>
</tr>
</tbody>
</table>

Supported Guest Operating Systems

A Horizon FLEX virtual machine can contain one of the following guest operating systems.

- Windows 10
- Windows 8.1
- Windows 7
- Windows XP
- Windows Server 2012 R2
- Ubuntu 14.04
Installing Horizon FLEX

The Horizon FLEX installation involves installing the Horizon FLEX server and client components, creating folders to store Horizon FLEX virtual machines, preparing Active Directory, setting up certificates, and creating and deploying Horizon FLEX virtual machines.

This chapter includes the following topics:

- “Horizon FLEX Installation Overview,” on page 13
- “Installing and Configuring Mirage Components for Horizon FLEX,” on page 14
- “Create a Download Folder for Horizon FLEX Virtual Machine Packages,” on page 15
- “Set Up a Certificate for the Horizon FLEX Server by Using OpenSSL,” on page 15
- “Configure the IIS SSL Server Certificate for the Horizon FLEX Server,” on page 16
- “Configure Active Directory Settings,” on page 16
- “Test the Horizon FLEX Admin Console Connection,” on page 17
- “Installing the Horizon FLEX Client for End Users,” on page 18

Horizon FLEX Installation Overview

Horizon FLEX is a combination of VMware components, including Mirage, Fusion Pro, and Workstation Player. The Horizon FLEX installation involves installing each of these components and performing additional Horizon FLEX-specific tasks. For a successful Horizon FLEX deployment, you must understand the sequence of required tasks.

Before you install Horizon FLEX, verify that it meets all of the hardware and software requirements, that you have valid licenses, and that you have downloaded the Horizon FLEX component installers from the VMware Horizon FLEX product download page.

You install the Horizon FLEX by performing these steps:

1. Install the Mirage system.
   

2. Set up certificates for Horizon FLEX virtual machines.
   

3. Create a download folder for storing your Horizon FLEX virtual machine packages.
   
   See “Create a Download Folder for Horizon FLEX Virtual Machine Packages,” on page 15.

4. Add a virtual directory in IIS for your Horizon FLEX virtual machine download folder and edit the site bindings.
See “Configure the IIS SSL Server Certificate for the Horizon FLEX Server,” on page 16.

5 (Optional) Configure Horizon FLEX to synchronize entities in only a selected Active Directory organizational unit (OU).

See “Configure Active Directory Settings,” on page 16.

6 Test the connection to the Horizon FLEX Admin Console.

See “Test the Horizon FLEX Admin Console Connection,” on page 17.

7 Install a Horizon FLEX Client on each end-user host, or instruct end users to install a Horizon FLEX Client on their own computers.

See “Installing the Horizon FLEX Client for End Users,” on page 18.

8 Create and deploy Horizon FLEX virtual machines.

See Chapter 4, “Creating and Deploying Horizon FLEX Virtual Machines,” on page 31.

Installing and Configuring Mirage Components for Horizon FLEX

The first Horizon FLEX installation step is to install and configure the Mirage system.

The Horizon FLEX package includes the following components:
- VMware Mirage for Horizon FLEX (the Mirage Core Software)
- Mirage PowerCLI for Windows
- Mirage Gateway Appliance Software

Download the installation files from the Horizon FLEX Server product download page.

The Mirage deployment involves the installation of the following components.

1. Mirage Management Server
2. Mirage Server
3. Mirage Management Console
4. Mirage Web manager

To install and configure the Mirage system, follow the installation instructions in the Mirage documentation at https://www.vmware.com/support/pubs/mirage_pubs.html.

When you install the Mirage system, you must select certain options for the Horizon FLEX server to operate correctly.

- The Mirage Server and Mirage console are only required if you are installing the Mirage client in the source virtual machines.
- If placing the virtual machine images on the same system as the Horizon FLEX Server, place the images in the IIS "Default Web" server.
- The Web Management Server and the Mirage Management Server can be installed on the same server, but installing them on different servers improves scalability. The SQL server should be installed on a separate server from the Web Management Server and the Mirage Management Server.
- During Mirage server installation, choose SSL for the Mirage server transport. SSL is required to use the Mirage Gateway feature for external access and management of Horizon FLEX systems. Before configuring the Mirage Server for SSL, you must install the server SSL certificate.
- Before you install the Mirage Web Manager, verify that .NET Framework 4.5.1 is installed on the server.
- The Mirage Management Server must run as a user who has Active Directory read permissions. If you plan to join Horizon FLEX virtual machines to an Active Directory domain, the Mirage Management Server must run as a user who has domain join permissions.
Create a Download Folder for Horizon FLEX Virtual Machine Packages

During the Horizon FLEX virtual machine deployment process, you compress your source virtual machine packages into TAR (.tar) format so that end users can easily download their Horizon FLEX virtual machines. You must create a download folder for storing these TAR files.

Procedure

1. Create the download folder on the Horizon FLEX server or on another server.
   - The download folder does not need to be on the Horizon FLEX server, but the files it contains must be downloadable without any authentication challenge. If you create the download folder on the same IIS server as the Horizon FLEX server, you can create the folder under the default IIS document root folder of the Default Web site. Do not create the download folder under the VMware Mirage Management Web site.

2. Assign permissions to the download folder so that users can download the files that it contains.

3. (Optional) Share the download folder with an administrative group, such as Horizon FLEX Admins. This can be an administrative group for users to manage Horizon FLEX deployments. This step can make it easier to register your source virtual machines with the Horizon FLEX Policy Server.

What to do next

See “Configure the IIS SSL Server Certificate for the Horizon FLEX Server,” on page 16.

Set Up a Certificate for the Horizon FLEX Server by Using OpenSSL

You can create a self-signed certificate for the Horizon FLEX server by using OpenSSL.

Prerequisites

The OpenSSL configuration file is created on the Mirage Gateway Server. See the Mirage documentation at https://www.vmware.com/support/pubs/mirage_pubs.html.

Procedure

1. At the OpenSSL command prompt, create a certificate: 
   ```bash
   openssl req -new -days expiration time -x509 -newkey rsa:2048 - keyout key filename -out certificate filename -nodes
   ```
   - `expiration time` represents the number of days that the certificate should be valid,
   - `key filename` represents the filename for the key,
   - `certificate filename` represents the new certificate name.
   - A self-signed certificate and a private key are generated. The certificate uses a 2048-bit RSA key and does not protect the key with a passphrase.

2. When prompted, enter the country name, state name, locality, organization name, and organizational unit name.

3. In the Common Name text box, enter the host name of the Horizon FLEX server to be protected.
   - This text box must be completed.

4. Enter the email address.
   - The self-signed certificate and associated private key are generated.
If the private key must be in .pfx format, enter the following command by using the certificate name and key filename generated in the previous steps:

```bash
$ openssl pkcs12 -export -out output pfx filename -inkey key filename -in certificate name
```

A new password-protected .pfx file is generated that can be deployed on any device that requires .pfx certificates instead of PEM certificates.

**Configure the IIS SSL Server Certificate for the Horizon FLEX Server**

You must configure the IIS SSL server certificate for the Horizon FLEX server to set the certificate chain from the Horizon FLEX server to the Horizon FLEX virtual machines.

**Prerequisites**

- Install the Server SSL Certificate on the Mirage server. See the Mirage documentation at https://www.vmware.com/support/pubs/mirage_pubs.html
- Create a download folder for your Horizon FLEX virtual machine packages. See “Create a Download Folder for Horizon FLEX Virtual Machine Packages,” on page 15.

**Procedure**

1. Open IIS Manager.
2. Navigate to VMware Mirage Management Web Site and select the file location for the download folder.
3. Right-click the folder location and select Add Virtual Directory.
4. Type a name in the Alias text box, browse to the folder that you created to contain the Horizon FLEX virtual machine packages, and click OK.
5. Navigate to the root node, the connection node defined for the Mirage server.
6. On the Mirage Home page under IIS, double click Server Certificates.
7. The IIS SSL server certificates window opens.
8. Click Import in the right column. This step imports the created SSL certificate and assigns a key to identify the certificate.
9. Select VMware Mirage Management Web Site and click Edit Bindings in the right column.
10. Set the HTTPS port to use your Horizon FLEX server certificate and click OK.

**Configure Active Directory Settings**

When you entitle a Horizon FLEX virtual machine, you add users and groups from your existing Active Directory infrastructure to the entitlement. By default, Horizon FLEX synchronizes your entire Active Directory infrastructure with the Horizon FLEX database. You can optionally configure Horizon FLEX to synchronize only a specific organization unit (OU).

**Prerequisites**

Install Mirage for Horizon FLEX. See “Installing and Configuring Mirage Components for Horizon FLEX,” on page 14.
**Procedure**

1. Start the Horizon FLEX Admin Console.
   a. In a Web browser, enter `https://WebManagerServer:7443/rvm`, where `WebManagerServer` is the DNS name or IP address of the host where the Mirage Web Manager is installed.
   b. Enter the user name and password of a domain account that has access to Mirage.
   c. Click **Login**.

2. In the Horizon FLEX Admin Console, click the **General System Settings** icon and click **Active Directory Settings**.

3. Type the OU to synchronize in the **Organizational Unit** text box.
   As you begin to type in the text box, the available OUs in your Active Directory infrastructure appear in a drop-down menu and you can select the appropriate OU.

4. Click **OK** to save the OU setting.
   The Horizon FLEX server validates the OU to verify that it exists and is accessible.
   The Horizon FLEX server synchronizes the Active Directory entities that belong only to the OU that you selected, including entities that belong to any child OUs of the selected OU.
   Any time you configure a new OU, the Horizon FLEX server deletes the previously synchronized entities from the database and starts a new full synchronization process.
   You can configure the policy for client virtual machines so that the power-on password matches the user’s Active Directory password after first startup. See “Configure a General Policy for a Horizon FLEX Image,” on page 39.

**Test the Horizon FLEX Admin Console Connection**

You can verify your Horizon FLEX deployment by testing the Horizon FLEX Admin Console connection.

**Prerequisites**


**Procedure**

1. Start the Horizon FLEX Admin Console.
   a. In a Web browser, enter `https://WebManagerServer:7443/rvm`, where `WebManagerServer` is the DNS name or IP address of the host where the Mirage Web Manager is installed.
   b. Enter the user name and password of a domain account that has access to Mirage.
   c. Click **Login**.

2. Verify that the Horizon FLEX Admin Console page appears correctly.
   The **Images**, **Policies**, **Entitlements**, and **Virtual Machines** buttons should be visible in the left navigation panel.
Installing the Horizon FLEX Client for End Users

End users must have the Horizon FLEX Client software installed on their local computers before they can download the Horizon FLEX virtual machines. Supported clients included in the Horizon FLEX package are Fusion Pro for Mac OS X machines and Workstation Player for Windows machines.

You can create a mass deployment to install the Horizon FLEX Client on many systems at one time, or you can instruct end users to obtain the Horizon FLEX Client from the VMware Web site and install it themselves. You can also run an unattended Workstation Player installation on multiple Windows machines.

Create a Mass Deployment Package to Install Fusion Pro

You can create a Fusion Pro mass deployment package to install Fusion Pro on any number of end-user Macs. You can use standard package deployment tools, including Apple Remote Desktop Admin, to deploy the mass deployment package.

When you configure the mass deployment package, specify your Horizon FLEX license key in the [Volume License] section of the Deploy.ini file and place a copy of the Fusion Pro application in the 00Fusion_Deployment_Items folder.

You can use the optional connectAtStartupURL parameter in the [Locations] section of the Deploy.ini file to specify a user name and the host name of your Horizon FLEX server, for example:

```
connectAtStartupURL = vmware-rvm://johndoe@yourflexserver.com:7443
```

If no virtual machines are installed on the user's Mac when the user launches Fusion Pro, the Connect dialog box opens and the Server and Username text boxes are prepopulated with the host name and user name that you specified in the connectAtStartupURL parameter.

For step-by-step information about creating a mass deployment package, see the VMware knowledge base article at http://kb.vmware.com/kb/2058680.

Provide a Workstation Player Installation Package to End Users

You can install Workstation Player on end user machines using a command line and specify the Horizon FLEX server connection settings by using a uniform resource identifier (URI). When installation of Workstation Player is complete, the end user is prompted to connect to a server and download a Horizon FLEX virtual machine.

Prerequisites

- Give the end user a password for the server and the Workstation Player license key for use with Horizon FLEX.

Procedure

- Construct a URI to create a customized Workstation Player installation and deployment package.
  
  The command line has the following structure:

  ```
  VMware-player-x.x.x-xxxxxxx.exe /v PLAYER_RVM_URI="vmware-rvm://username@myserver.com:7443"
  ```

  Specify the version and build number of the Workstation Player .exe file. `username` is the user's login name and `myserver.com` is the host name of the server. You must include `vmware-rvm://` and `:7443` in the server address. Do not include http or https in the server address.
Run an Unattended Workstation Player Installation

You can use the unattended installation feature of the Microsoft Windows Installer (MSI) to install Workstation Player on several Windows hosts without having to respond to wizard prompts. This feature is convenient in a large enterprise.

Prerequisites

- Verify that the host system meets the host system requirements.
- Verify that the host computer has version 2.0 or later of the MSI runtime engine. This version of the installer is available in versions of Windows beginning with Windows XP and is available from Microsoft. See the Microsoft Web site for more information.

Procedure

1. Log in to the host system as the administrator user or as a user who is a member of the local Administrators group.
   - If you log in to the domain, the domain account must also be a local administrator.
2. Extract the administrative installation image from the Workstation Player setup file.
   - The setup filename is similar to `VMware-player-xxxx-xxxx.exe`, where `xxxx-xxxx` is the version and build number.
   - For example: `setup.exe /s /e install_temp_path`
3. Enter the installation command on one line.
   - These examples show options that you can add to the command.
     - `VMware-player-full-x.x.x-xxxxxx.exe /s /pass /v/qn REBOOT=ReallySuppress "EULAS_AGREED=1 INSTALLDIR="""" ADDLOCAL=ALL SERIALNUMBER="xxxxx-xxxxxx-xxxxxx-xxxxxx""
     - `VMware-player-full-x.x.x-xxxxxx.exe /s /v/qn EULAS_AGREED=1 SERIALNUMBER="xxxxx-xxxxxx-xxxxxx-xxxxxx"
     - `VMware-player-full-x.x.x-xxxxxx.exe /s /v/qn PLAYER_RVM_URI="vmware-rvm://username@myserver.com:7443"
   - You can use the optional INSTALLDIR property to specify a file path for the installation that is different from the default location.

   **Note:** The quotation marks around the file path are important. All the MSI arguments are passed with the `/v` option. The outer quotation marks group the MSI arguments and the inner quotation marks put a quotation mark in that argument.

4. You can use the optional REMOVE property to skip the installation of certain features.

Workstation Player Unattended Installation Properties

When you perform an unattended installation of Workstation Player, you can customize the installation by specifying installation properties in the installation command.

To specify an installation property in the installation command, use the format `Property property="value"`. A value of 1 means true and a value of 0 means false.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTHD_PORT</td>
<td>Specifies which port the &quot;VMware Authorization Service&quot; communicates through.</td>
<td>902</td>
</tr>
<tr>
<td>AUTOSOFTWAREUPDATE</td>
<td>Enables automatic upgrades for Workstation Player when a new build becomes available.</td>
<td>1</td>
</tr>
<tr>
<td>DATACOLLECTION</td>
<td>Sends user experience information to VMware.</td>
<td>1</td>
</tr>
<tr>
<td>DESKTOP_SHORTCUT</td>
<td>Adds a shortcut on the desktop when Workstation Player is installed.</td>
<td>1</td>
</tr>
<tr>
<td>EULAS_AGREED</td>
<td>Allows you to silently accept the product EULA's. Set to 1 to complete the installation or upgrade.</td>
<td>0</td>
</tr>
<tr>
<td>INSTALL_DIR</td>
<td>Install Workstation Player in a directory that is different from the default Workstation Player location.</td>
<td>C:\Program Files (86)\VMware\VMware Player</td>
</tr>
<tr>
<td>KEEP_LICENSE</td>
<td>Specifies whether to keep or remove license keys when Workstation Player is installed.</td>
<td>1</td>
</tr>
<tr>
<td>KEEP_SETTINGFILES</td>
<td>Specifies whether to keep or remove settings files when Workstation Player is uninstalled.</td>
<td>1</td>
</tr>
</tbody>
</table>
| PLAYER_RVM_URI      | Specifies the uniform resource identifier (URI) for the Horizon FLEX server.                      | VMware-player-full-x.x.x-xxxxxxx-xxxxx-xxxxx-xxxxx \rvm://username@myserver.com:7443 \n
PLAYER_RVM_URI="vmware-rvm://username@myserver.com:7443" |
| SERIALNUMBER        | Lets you enter the license key when Workstation Player is installed. Enter the license key with hyphens, for example xxxxx-xxxxx-xxxxx-xxxxx-xxxxx. |                                        |
| SIMPLIFIEDUI        | Turn on or off certain UI features of Workstation Player.                                         | 0                                      |
| SOFTWAREUPDATEURL   | Specifies a custom URL for managing software updates (separate from vmware.com).                  |                                        |
| STARTMENU_SHORTCUT  | Adds a Start menu item when Workstation Player is installed.                                       | 1                                      |
| SUPPORTURL          | Set a support URL or email alias specifically for your users to contact with product issues through the Workstation Player Help menu. |                                        |
Before you create and deploy Horizon FLEX virtual machines, you must set up certificates to ensure that end users can successfully download and use their virtual machines.

VMware recommends that you use a certificate that is issued by a certificate authority (CA), such as Entrust or Go Daddy, or a third-party certificate, on your Horizon FLEX server. If you are using a self-signed certificate or a certificate from an internal CA instead of a generally trusted certificate, you must take steps to ensure that the certificate is trusted on all end-user computers that will download and use Horizon FLEX virtual machines.

For information about setting up certificates in Mirage for the Horizon FLEX Server, see the Mirage documentation at https://www.vmware.com/support/pubs/mirage_pubs.html.

This chapter includes the following topics:

- “Creating a Trusted Certificates List,” on page 21
- “Using Self-Signed Certificates,” on page 24
- “Using Internal CA Certificates,” on page 27

### Creating a Trusted Certificates List

You can create a list of trusted certificates for Horizon FLEX virtual machines and import the list to the Horizon FLEX Policy Server. When you use a trusted certificates list, you do not need to install certificates on end-user hosts.

Using a list of trusted certificates can prevent malicious users from creating their own self-signed certificates for the same hostname and adding those certificates to their host’s list of trusted certificates.

When you configure the Horizon FLEX Policy Server to use a trusted certificates list, the client host ignores the host’s list of certificates and uses the trusted certificates list to verify server connections instead. If the client host cannot verify a certificate by using the trusted certificates list, the server connection fails.

If the trusted certificates list is empty in the source virtual machine, Workstation Player and Fusion Pro authenticate against the host’s list of trusted certificates.

To create the trusted certificates list, you export each certificate to a separate file and then concatenate all of the files into a single file. You use the Horizon FLEX Admin Console to import the concatenated certificates file to the Horizon FLEX Policy Server.

You must export certificates in Privacy Enhanced Mail (PEM) format. On Windows systems, the PEM certificate encoding is called Base-64 encoded X.509 (.CER). Only PEM-encoded certificates are supported. No other certificate format (DER, Serialized Certificate Store/SST, PKCS #12/PFX, PKCS #7/P7B) is accepted.
About the PEM Format

The PEM format is a standard certificate format that is Base64 encoded.

An example of a PEM-format certificate is as follows:

```
-----BEGIN CERTIFICATE-----
MIIDojCCAwugAwIBAgIJAMLM0CJRzPyzMA8GCsqGS1bDQEBAQdBGQwIBADMAwE
VQQGEwJVUzETMBEGA1UECBMKQ2FsaWZvcm5pYTESMBAGA1UEBxMJUGFsbyBBbHRv
MS8wU0w9QHcuNDAyMjY0FowgZMxcCzA3JgNVAYTAlVTMRMw
EQYDVQQIEwpDYWxpZm9ybmlhMR1wEAYDVQQHEwIqYXwvIEFsdG8lZAtBgNVBAoT
JlZNd2FyZSwgSwIjIAtIFdvcmxzZGF0dW9uIFNITCBEUXZoaW5nMseAYDVQQD
EyFb3Jr3RhdGlvb1B0ZXJ3b3wZy2FbZBBDxRbyb3Jpb2psdHzgwCQYDVQQG
-----END CERTIFICATE-----
```

When you create a trusted certificates list, you concatenate multiple PEM-format certificates into a single file. Line endings are auto-detected. The following example shows the format of a concatenated certificates list that contains two certificates.

```
-----BEGIN CERTIFICATE-----
<base64 content here>
-----END CERTIFICATE-----
-----BEGIN CERTIFICATE-----
<base64 content here>
-----END CERTIFICATE-----
```

Creating PEM-Format Certificates

You can create PEM-format certificates by downloading the certificate from the CA's Web site or by exporting the certificates from a host system.

For example, you can download certificates for Verisign from the Symantec Web site at https://www.symantec.com/page.jsp?id=roots.

Export a PEM-Format Certificate From a Mac

You can export a PEM-format certificate from a Mac.

Prerequisites

Become familiar with how to use Keychain Access on a Mac. For more information, see the Apple Support Web site at http://support.apple.com.
Procedure
1 On the Mac, open Keychain Access.
2 From the sidebar, select System Roots.
3 Locate the certificate to export.
4 Select File > Export Items.
5 Select a location to save the certificate and select the Privacy Enhanced Mail (.pem) file format.

Export a PEM-Format Certificate From a Windows System
You can export a PEM-format certificate from a Windows system. On Windows, the PEM certificate encoding is called Base-64 encoded X.509 (.CER).

Prerequisites
Become familiar with how to use Certificate Manager on a Windows system. For more information, see the Microsoft TechNet Web site at http://technet.microsoft.com.

Procedure
1 On the Windows system, open Certificate Manager (certmgr.exe).
2 Right-click the certificate to export and select All Tasks > Export.
3 Select options in the Certificate Export Wizard.
   a Select Base-64 encoded X.509 (.CER) for the file export format.
      For the certificate to work with Horizon FLEX, you must choose this option.
   b Provide a location to save the certificate and a file name.
   c Review the settings you selected and click Finish.
   The certificate file is saved to the location you indicated.

Create and Import the Trusted Certificates List File
After you export your PEM-format certificates, you must construct the trusted certificate list and import the certificates list file to the Horizon FLEX Policy Server.

Prerequisites
Export each certificate in PEM format. See “Creating PEM-Format Certificates,” on page 22.

Procedure
1 To create the trusted certificates list file, concatenate each PEM-format certificate file into a single file.
   You can use the cat command, or you can copy and paste the contents of the certificate files into a text
   file. You can safely edit Base64 content in a text editor.
   For example: $ cat mycert1.pem mycert2.pem mycert3.pem > list.pem
2 Start the Horizon FLEX Admin Console.
   a In a Web browser, enter https://WebManagerServer:7443/rvm, where WebManagerServer is the DNS
      name or IP address of the host where the Mirage Web Manager is installed.
   b Enter the user name and password of a domain account that has access to Mirage.
   c Click Login.
3 In the Horizon FLEX Admin Console, click the General System Settings icon and select Certificates.
Click **Import**, browse to the trusted certificates list file, and click **Open** to import the file.

### Updating Certificates on the Server

When a certificate expires, and a new certificate has an expiration date that is set far into the future, you can add the new certificate as a second certificate to the trusted certificates list in the Horizon FLEX Policy Server.

Adding the new certificate to the trusted certificates list enables all Horizon FLEX virtual machines to download the new certificate. Then, when the certificate switch occurs, all of the Horizon FLEX virtual machines that received the new list of certificates can connect to the Horizon FLEX server and you can remove the old trusted certificate from the policy file.

If you change the server certificate after the Horizon FLEX virtual machines have already been registered and run, then your end users need to verify that the changed certificate is trusted by Fusion Pro or Workstation Player. If the new server certificate is self-signed, the Horizon FLEX client does not report the instance status correctly to the Horizon FLEX server. The end user should open the Horizon FLEX virtual machine and click **Connect** to connect to the server. If the end user receives the **Invalid security certificate** error message, the end user should confirm with you to verify the certificate is valid and if so, select the **Always trust this host with this certificate** check box and click **Connect Anyway**.

### Using Self-Signed Certificates

If you do not configure the self-signed certificate into the source virtual machine being prepared, you must install the certificate on each end-user host for Horizon FLEX virtual machines to function correctly.

If the list of certificates is empty in the policy file, Workstation Player and Fusion Pro will fall back to authenticating against the host’s list of trusted certificates.

If you include the self-signed certificate of a source virtual machine on the Horizon FLEX Policy Server, and you configure or install the self-signed certificate for the Horizon FLEX Client (either in the source virtual machine’s policy file or in the host’s list of trusted certificates), you do not need to install the certificate on end-user hosts when certificate updates are required, for example, when a certificate expires.

For information about configuring certificates into a source virtual machine, see “Create a Source Virtual Machine in Fusion Pro,” on page 32.

For information about creating a trusted certificates list and importing it to the Horizon FLEX Policy Server, see “Creating a Trusted Certificates List,” on page 21.

For information about updating certificates, see “Updating Certificates on the Server,” on page 24.

### Install a Self-Signed Certificate on a Windows Computer

To install a self-signed certificate on a Windows host, you export the certificate from your Horizon FLEX server and import it to the Windows computer.

**Prerequisites**

- Become familiar with how to install and use the MMC Certificates snap-in on a Windows system. For more information, go to the Windows TechNet Web site at [http://technet.microsoft.com](http://technet.microsoft.com).
- Install Windows IIS.
**Procedure**

1. Export the self-signed certificate from your Horizon FLEX server.
   a. On the Horizon FLEX server, start MMC (`mmc.exe`), add the Certificates snap-in for a computer account, and manage certificates for the local computer.
   b. Select `File > Add/Remove Snap-in`.
   c. Click the Certificates snap-in and click `Add`.
   d. On the Certificates snap-in display, select `Computer account` and click `Next`.
      This setting is required by the Horizon FLEX server.
   e. Select `Local Computer` and click `Finish` and then `OK`.
   f. In the left navigation pane, expand `Certificates (Local Computer)`.
   g. Right-click on Trusted Root Certification Authorities and select All Tasks > Import.
      The Certificate Import Wizard opens.
   h. Click `Next`.
   i. Browse for the root certificate file and click `Next`.
   j. Select Place all certificates in the following store: Trusted Root Certification Authorities and click `Next`, then click `Finish`.
   k. Right-click on Intermediate Root Certification Authorities and select All Tasks > Import.
   l. The Certificate Import Wizard opens.
   m. Browse for the root certificate file and click `Next`.
   n. Select Place all certificates in the following store: Intermediate Root Certification Authorities and click `Next`, then click `Finish`.
   o. Repeat steps m. and n. for each intermediate certificate to be installed.
   p. Navigate to Trusted Root Certification Authorities > Certificates.
   q. Select and export the self-signed certificate.
      Export the certificate in DER-encoded binary X.509 (.CER) format.

2. Copy the self-signed certificate to the client Windows computer.

3. Import the self-signed certificate to the client Windows computer.
   a. On the Windows computer, start MMC (`mmc.exe`).
   b. Add the Certificates snap-in for the computer account and manage certificates for the local computer.
   c. Import the self-signed certificate into Trusted Root Certification Authorities > Certificates.

The self-signed certificate is now trusted for all users.

**Install a Self-Signed Certificate on a Mac**

To install a self-signed certificate on a Mac host, you export the certificate from your Horizon FLEX server and import it to the Mac.

**Prerequisites**

- Become familiar with how to install and use the MMC Certificates snap-in on a Windows system. For more information, go to the Windows TechNet Web site at [http://technet.microsoft.com](http://technet.microsoft.com).
- Install Windows IIS.

**Procedure**

1. Export the self-signed certificate from your Horizon FLEX server.
   a. On the Horizon FLEX server, start MMC (mmc.exe), add the Certificates snap-in for a computer account, and manage certificates for the local computer.
   b. Select File > Add/Remove Snap-in.
   c. Click the Certificates snap-in and click Add.
   d. On the Certificates snap-in display, select Computer account and click Next.
      This setting is required by the Horizon FLEX server.
   e. Select Local Computer and click Finish and then OK.
   f. In the left navigation pane, expand Certificates (Local Computer).
   g. Right-click on Trusted Root Certification Authorities and select All Tasks > Import.
      The Certificate Import Wizard opens.
   h. Click Next.
   i. Browse for the root certificate file and click Next.
   j. Select Place all certificates in the following store: Trusted Root Certification Authorities and click Next, then click Finish.
   k. Right-click on Intermediate Root Certification Authorities and select All Tasks > Import.
   l. The Certificate Import Wizard opens.
   m. Browse for the root certificate file and click Next.
   n. Select Place all certificates in the following store: Intermediate Root Certification Authorities and click Next, then click Finish.
   o. Repeat steps m. and n. for each intermediate certificate to be installed.
   p. Navigate to Trusted Root Certification Authorities > Certificates.
   q. Select and export the self-signed certificate.
      Export the certificate in DER-encoded binary X.509 (.CER) format.

2. Copy the self-signed certificate to the Mac.

3. Import the self-signed certificate on the Mac.
   a. Double-click the self-signed certificate to open it in Keychain Access.
      The self-signed certificate appears in login.
   b. Copy the self-signed certificate to System.
      You must copy the certificate to System to ensure that it is trusted by all users and local system processes, including the virtual machine (vmware-vmx) processes in Fusion Pro.
   c. Open the self-signed certificate in System, expand Trust, select Use System Default, and save your changes.
d Reopen the self-signed certificate in System, expand Trust, select Always Trust, and save your changes.

e Delete the self-signed certificate from login.

Using Internal CA Certificates

If you use a certificate from an internal CA instead of from a commercial CA such as Entrust or Go Daddy, and you do not configure the certificate into the source virtual machine being prepared, you must install the root CA certificate on each end-user host for Horizon FLEX virtual machines to function correctly.

**Note** Because the server certificate is signed by the root CA, you do not need to import the server certificate to end-user hosts.

If the list of certificates is empty in the policy file, Workstation Player and Fusion Pro will fall back to authenticating against the host's list of trusted certificates.

If you include the internal CA certificate of a source virtual machine on the Horizon FLEX Policy Server, and you configure or install the certificate for the Horizon FLEX Client (either in the source virtual machine's policy file or in the host's list of trusted certificates), you do not need to install the root CA certificate on end-user hosts when certificate updates are required, for example, when a certificate expires.

For information about configuring certificates into a source virtual machine, see “Create a Source Virtual Machine in Fusion Pro,” on page 32.

For information about creating a trusted certificates list and importing it to the Horizon FLEX Policy Server, see “Creating a Trusted Certificates List,” on page 21.

For information about updating certificates, see “Updating Certificates on the Server,” on page 24.

Install an Internal Root CA Certificate on a Windows Computer

To install an internal root CA certificate on a Windows host, you export the certificate from your Horizon FLEX server and import it to the Windows computer.

**Prerequisites**

- Become familiar with how to install and use the MMC Certificates snap-in on a Windows system. For more information, go to the Windows TechNet Web site at [http://technet.microsoft.com](http://technet.microsoft.com).
- Obtain and install an internal CA certificate. You can use the Windows MMC Certificates snap-in to request a certificate.
- Install Windows IIS.

**Procedure**

1 Export the root CA certificate from your Horizon FLEX server.
   a On the Horizon FLEX server, start MMC (mmc.exe), add the Certificates snap-in for a computer account, and manage certificates for the local computer.
   b Select File > Add/Remove Snap-in.
   c Click the Certificates snap-in and click Add.
   d On the Certificates snap-in display, select Computer account and click Next.
      This setting is required by the Horizon FLEX server.
   e Select Local Computer and click Finish and then OK.
   f In the left navigation pane, expand Certificates (Local Computer).
g Right-click on **Trusted Root Certification Authorities** and select **All Tasks > Import**.

The Certificate Import Wizard opens.

h Click **Next**.

i Browse for the root certificate file and click **Next**.

j Select **Place all certificates in the following store:** Trusted Root Certification Authorities and click **Next**, then click **Finish**.

k Right-click on **Intermediate Root Certification Authorities** and select **All Tasks > Import**.

l The Certificate Import Wizard opens.

m Browse for the root certificate file and click **Next**.

n Select **Place all certificates in the following store:** Intermediate Root Certification Authorities and click **Next**, then click **Finish**.

o Repeat steps m. and n. for each intermediate certificate to be installed.

p Navigate to **Trusted Root Certification Authorities > Certificates**.

q Select and export the root CA certificate.

Export the certificate in DER-encoded binary X.509 (.CER) format.

2 Copy the root CA certificate to the Windows computer.

3 Import the root CA certificate to the Windows computer.

a On the Windows computer, start MMC (**mmc.exe**).

b Add the Certificates snap-in for the computer account and manage certificates for the local computer.

c Import the root CA certificate into **Trusted Root Certification Authorities > Certificates**.

The root CA certificate is now trusted for all users.

### Install an Internal Root CA Certificate on a Mac

To install an internal root CA certificate on a Mac host, you export the certificate from your Horizon FLEX server and import it to the Mac.

**Prerequisites**

- Become familiar with how to install and use the MMC Certificates snap-in on a Windows system. For more information, go to the Windows TechNet Web site at [http://technet.microsoft.com](http://technet.microsoft.com).

- Become familiar with how to use Keychain Access on a Mac. For more information, go to the Apple Support Web site at [http://support.apple.com](http://support.apple.com).

- Install Windows IIS.

**Procedure**

1 Export the root CA certificate from your Horizon FLEX server.

a On the Horizon FLEX server, start MMC (**mmc.exe**), add the Certificates snap-in for a computer account, and manage certificates for the local computer.

b Select **File > Add/Remove Snap-in**.

c Click the **Certificates** snap-in and click **Add**.
d  On the Certificates snap-in display, select Computer account and click Next.
   This setting is required by the Horizon FLEX server.

e  Select Local Computer and click Finish and then OK.

f  In the left navigation pane, expand Certificates (Local Computer).

g  Right-click on Trusted Root Certification Authorities and select All Tasks > Import.
   The Certificate Import Wizard opens.

h  Click Next.

i  Browse for the root certificate file and click Next.

j  Select Place all certificates in the following store: Trusted Root Certification Authorities and
   click Next, then click Finish.

k  Right-click on Intermediate Root Certification Authorities and select All Tasks > Import.

l  The Certificate Import Wizard opens.

m  Browse for the root certificate file and click Next.

n  Select Place all certificates in the following store: Intermediate Root Certification Authorities
   and click Next, then click Finish.

o  Repeat steps m. and n. for each intermediate certificate to be installed.

p  Navigate to Trusted Root Certification Authorities > Certificates.

q  Select and export the root CA certificate.
   Export the certificate in DER-encoded binary X.509 (.CER) format.

2  Copy the root CA certificate to the Mac.

3  Import the root CA certificate on the Mac.

   a  Double-click the root CA certificate to open it in Keychain Access.
   The root CA certificate appears in login.

   b  Copy the root CA certificate to System.
   You must copy the certificate to System to ensure that it is trusted by all users and local system
   processes, including the virtual machine (.vmx) processes in Fusion.

   c  Open the root CA certificate, expand Trust, select Use System Defaults, and save your changes.

   d  Reopen the root CA certificate, expand Trust, select Always Trust, and save your changes.

   e  Delete the root CA certificate from login.
Creating and Deploying Horizon FLEX Virtual Machines

You can create multiple Horizon FLEX virtual machines and entitle those virtual machines to a variety of end users, including Mac users. Users can be connected or disconnected from the enterprise network when they use their Horizon FLEX virtual machines. When you create a source virtual machine for a Horizon FLEX virtual machine, you must select certain options for the virtual machine to function correctly with Horizon FLEX.

You can use Fusion Pro or Workstation Pro (not included in the Horizon FLEX package) to create a source virtual machine.

This chapter includes the following topics:
- “Horizon FLEX Virtual Machine Deployment Overview,” on page 31
- “Create a Source Virtual Machine in Fusion Pro,” on page 32
- “Create a Source Virtual Machine in Workstation Pro (Not included in Horizon FLEX),” on page 33
- “Install the Mirage Client In a Source Virtual Machine,” on page 35
- “Prepare a Source Virtual Machine to Join an Active Directory Domain,” on page 36
- “Compress a Source Virtual Machine Package,” on page 37
- “Register a Source Virtual Machine with the Horizon FLEX Policy Server,” on page 37
- “Creating Policies and Entitlements,” on page 38
- “Create a URI to Deploy a Horizon FLEX Virtual Machine,” on page 46

Horizon FLEX Virtual Machine Deployment Overview

To deploy a Horizon FLEX virtual machine, you perform tasks in a specific order.

1. Create and configure a source virtual machine.
   See “Create a Source Virtual Machine in Fusion Pro,” on page 32 or “Create a Source Virtual Machine in Workstation Pro (Not included in Horizon FLEX),” on page 33.

2. (Optional) Prepare the source virtual machine to join an Active Directory domain.
   See “Prepare a Source Virtual Machine to Join an Active Directory Domain,” on page 36.

3. Compress the source virtual machine package and save it in your download directory.

4. Register the source virtual machine with the Horizon FLEX Policy Server.
   See “Register a Source Virtual Machine with the Horizon FLEX Policy Server,” on page 37.
Create a policy for the Horizon FLEX image and entitle the image to your Active Directory users and groups.


(Optional) Create a URI to deploy the Horizon FLEX virtual machine.

See “Create a URI to Deploy a Horizon FLEX Virtual Machine,” on page 46.

Create a Source Virtual Machine in Fusion Pro

You can use Fusion Pro to create a source virtual machine for a Horizon FLEX virtual machine. When you create a source virtual machine, you must set encryption and restriction information so that the virtual machine functions correctly with Horizon FLEX.

You can also use Workstation Pro to create a source virtual machine. Workstation Pro is not included in the Horizon FLEX package.

If you enable USB device use, drag and drop, and copy and paste features when you create the virtual machine, you can set policies in the Horizon FLEX Admin Console to enable or disable these features for end users. However, if you disable these features when you create the virtual machine, you cannot override the virtual machine settings to enable the features by setting policies.

Horizon FLEX only supports virtual machine names using English characters. Do not use non-ASCII characters in .vmx or .tar filenames. Fusion Pro cannot create Horizon FLEX virtual machines in Japanese or Simplified Chinese.

Note: When preparing a Horizon FLEX virtual machine, make sure that the .vmx policy file is in the same folder as all virtual machine disk (.vmdk) files. If the .vmx file and the virtual machine disk files are in different directories on the client user’s machine, then the user will receive an error message when attempting to start the Horizon FLEX virtual machine.

Prerequisites

- Become familiar with how to create a virtual machine in Fusion Pro. See the Fusion documentation at https://www.vmware.com/support/pubs/fusion_pubs.html.
- Become familiar with the supported guest operating systems for Horizon FLEX virtual machines. See “Supported Host and Guest Operating Systems,” on page 12.
- Install Fusion Pro with a Horizon FLEX license key.

Procedure

1. Open Fusion Pro and create a virtual machine.

   Select a guest operating system that is supported for Horizon FLEX virtual machines. When the virtual machine is created, Fusion Pro tries to install VMware Tools. Configure the virtual machine for distribution to your end users.

2. From the Virtual Machine Library, select the new virtual machine and select Settings > Encryption & Restrictions.

3. Select Enable Encryption and set a password for opening the virtual machine.

   The password must be six characters or longer. You must give this encryption password to your end users to enable them to open the virtual machine.

   You must retain the encryption password. You cannot access the virtual machine without this password.
4 Check Enable Restrictions and set a password for editing the restrictions on the virtual machine. This password should be different than the virtual machine encryption password. You must retain the restrictions password. You cannot edit the restrictions on the virtual machine without this password.

5 Click Configure. The restrictions configuration window opens.

6 Set the Restriction Type to Managed. You must set the restriction type to Managed to distribute and use the virtual machine with Horizon FLEX.

7 Type the URL of the Horizon FLEX server on which you intend to host the virtual machine in the Restrictions Management Server text box.

8 Click Check Server to verify the Horizon FLEX server URL.

9 (Optional) To add trusted certificates to the virtual machine, click the + button and navigate to the location of each certificate file. If you add certificates to the virtual machine, the Horizon FLEX Client uses the certificates in the virtual machine and does not use the certificates on the host. To do certificate control and setup on the Horizon FLEX Policy Server for all Horizon FLEX virtual machines, leave the certificates box blank.

10 Click Save.

11 Click the Lock icon to prevent further changes to the restrictions of the virtual machine. You can edit restrictions for the virtual machine by using the restrictions password.

What to do next
If you intend to join the Horizon FLEX virtual machine to an Active Directory domain, prepare the virtual machine to join the domain. See “Prepare a Source Virtual Machine to Join an Active Directory Domain,” on page 36.

To install the Mirage client in the source virtual machine, see “Install the Mirage Client In a Source Virtual Machine,” on page 35.

Create a Source Virtual Machine in Workstation Pro (Not included in Horizon FLEX)

You can use Workstation Pro to create a source virtual machine for a Horizon FLEX virtual machine. Workstation Pro is not included in the Horizon FLEX package. A Horizon FLEX license key for Workstation Pro is not required.

Horizon FLEX only supports virtual machine names using English characters. Do not use non-ASCII characters in .vmx or .tar filenames.

Note When preparing a Horizon FLEX virtual machine, make sure that the .vmx policy file is in the same folder as all virtual machine disk (.vmdk) files. If the .vmx file and the virtual machine disk files are in different directories on the client user’s machine, then the user will receive an error message when attempting to start the Horizon FLEX virtual machine.

Prerequisites
- Review how to create a virtual machine in Workstation Pro. See the Workstation Pro documentation at https://www.vmware.com/support/pubs/ws_pubs.html
Review the supported guest operating systems for Horizon FLEX virtual machines. See “Supported Host and Guest Operating Systems,” on page 12.

Install Workstation.

Procedure

1. Open Workstation Pro and create a virtual machine. When the virtual machine is created, Workstation Pro tries to install VMware Tools.

2. Install the guest OS.
   
   Select a guest operating system that is supported for Horizon FLEX virtual machines. Configure the virtual machine for distribution to your end users.

3. Encrypt and restrict the virtual machine. Select the virtual machine and select **VM > Settings**.

4. On the **Options** tab, select **Access Control**.

5. Click **Encrypt**, type an encryption password, and click **Encrypt**.
   
   The encryption password is required to gain access to the virtual machine. It does not prevent the user from changing the virtual machine configuration. Turn on restrictions and enter a password to prevent the user from changing the virtual machine configuration.

   **IMPORTANT** Record the encryption password you use. If you forget the password, Workstation does not provide a way to retrieve it.

   Workstation begins encrypting the virtual machine. After the encryption process is complete, you can set a restrictions password.

6. Select the **Enable Restrictions** check box and set a password for editing the restrictions on the virtual machine.
   
   Set a different password than the virtual machine encryption password.
   
   You must retain the restrictions password. You cannot edit the restrictions on the virtual machine without this password.

7. Set the **Restriction Type** to **Managed**.
   
   You must set the restriction type to **Managed** to distribute and use the virtual machine with Horizon FLEX.

8. Enter the URL of the Horizon FLEX server on which you intend to host the virtual machine in the **Restrictions Management Server** text box.

9. Click **Check Server** to verify the Horizon FLEX server URL.

10. (Optional) To add trusted certificates to the virtual machine, click the **Manage Certificates** icon and navigate to the location of each certificate file.
    
    If you add certificates to the virtual machine, the Horizon FLEX Client uses the certificates in the virtual machine and does not use the certificates on the host. To do certificate control and setup on the Horizon FLEX Policy Server for all Horizon FLEX virtual machines, leave the certificates box blank.

11. Click **Save**.

What to do next

If you intend to join the Horizon FLEX virtual machine to an Active Directory domain, prepare the virtual machine to join the domain. See “Prepare a Source Virtual Machine to Join an Active Directory Domain,” on page 36.

To install the Mirage client in the source virtual machine, see “Install the Mirage Client In a Source Virtual Machine,” on page 35.
Install the Mirage Client In a Source Virtual Machine

If the source virtual machine has a Windows guest operating system, you can install the Mirage client in the virtual machine. Installing the Mirage client is optional.

If you install the Mirage client in a source virtual machine, you can select disaster recovery scenarios when you entitle the virtual machine. For example, you can select an option to make the Mirage server create a CVD for the Horizon FLEX virtual machines that the end user downloads. Mirage periodically synchronizes end-user data into the datacenter based on the selected Mirage policy. You can use this data to restore the CVD or access files on the virtual machine by using the Mirage File Portal in the main Mirage Management Console.

**NOTE** When configuring the Mirage server for disaster recovery, make sure the MongoDB ports are configured correctly. For more information, see the *VMware Mirage Installation Guide*.

**Prerequisites**

- Create the source virtual machine. See “Create a Source Virtual Machine in Fusion Pro,” on page 32 or “Create a Source Virtual Machine in Workstation Pro (Not included in Horizon FLEX),” on page 33.
- Obtain the *VMware Mirage Installation Guide* for Mirage client installation instructions.

**Procedure**

1. In Fusion Pro or Workstation Pro, start the source virtual machine and log in to the guest operating system.
2. Install the latest version of VMware Tools.
   a. From the menu bar, select **Virtual Machine > Install VMware Tools**.
   b. Click **Next** to progress through the installation.
   c. Select **Complete**, unless you need to exclude certain features of VMware Tools, and click **Next**.
   d. Click **Install**.
   e. When the installation finishes, click **Yes** to restart the virtual machine.
3. Install the Mirage client in the source virtual machine.
   See the *VMware Mirage Installation Guide* for more information.
4. In the Mirage Management Console, verify that the endpoint appears as Pending Assignment.
   **NOTE** Do not delete this Pending record as long as you are distributing this source virtual machine.
5. In the Mirage Management Console, enable automatic CVD creation.
   a. Right-click **System Configuration** and select **Settings**.
   b. Click the **CVD Auto Creation** tab.
   c. Select **Enable automatic CVD creation**.
      You can change the user message as needed.
   d. Click **OK**.
6. Power off the source virtual machine in Mirage while it is in Pending Assigning state.
   Do not provide the username and password, and do not register the source virtual machine at the Mirage client prompt. If you do register the source virtual machine with Mirage, the Horizon FLEX virtual machine will be duplicated when the end user accesses it.
Once the Mirage client is active, when you create a new Horizon FLEX entitlement for this source virtual machine, Mirage controls for that virtual machine are available.

**Prepare a Source Virtual Machine to Join an Active Directory Domain**

If you intend to join a Horizon FLEX virtual machine to a specific Active Directory domain, you must prepare the source virtual machine to join the domain before you register it with the Horizon FLEX Policy Server.

**Prerequisites**

- Create a source virtual machine. See “Create a Source Virtual Machine in Fusion Pro,” on page 32 or “Create a Source Virtual Machine in Workstation Pro (Not included in Horizon FLEX),” on page 33.

  **NOTE**  Do not install Windows 7 Home edition or a non-Windows guest operating system in the source virtual machine. You cannot join a Windows 7 Home edition operating system or a non-Windows guest operating system to a domain.

- Verify that you have the administrator password for the source virtual machine.

- In the Horizon FLEX Admin Console, set the policy for the virtual machine to join the Active Directory domain. The Horizon FLEX administrator account must have permission to create objects in the Active Directory.

- An RODC must be installed in the DMZ.

- Configure the Active Directory to support the domain join.

**Procedure**

1. In Fusion Pro, start the source virtual machine and log in to the guest operating system.

2. (Optional) Turn off **Windows update**.

3. Install the latest version of VMware Tools.
   a. From the menu bar, select **Virtual Machine > Install VMware Tools**.
   b. Click **Next** to progress through the installation.
   c. Select **Complete**, unless you need to exclude certain features of VMware Tools, and click **Next**.
   d. Click **Install**.
   e. When the installation finishes, click **Yes** to restart the virtual machine.

4. Run **install-rvmssetup.cmd** as an administrator to install the VMware RVM Setup Service in the source virtual machine.

   The VMware RVM Setup Service performs the domain join operation. **install-rvmssetup.cmd** is included with VMware Tools.

5. Open the Windows Services snap-in (**services.msc**) and verify that the VMware RVM Setup Service startup type is set to Automatic.

6. Shut down the source virtual machine.

   The VMware RVM Setup Service starts the next time you boot up the source virtual machine.
Compress a Source Virtual Machine Package

You must compress the source virtual machine package in TAR (`.tar`) format so that end users can easily download the virtual machine. A virtual machine package (sometimes called a bundle) includes all of the virtual machine files that are required to run a virtual machine.

**Prerequisites**

- Create the source virtual machine. See “Create a Source Virtual Machine in Fusion Pro,” on page 32 or “Create a Source Virtual Machine in Workstation Pro (Not included in Horizon FLEX),” on page 33.

- Create and configure a download folder for your Horizon FLEX virtual machine packages. See “Create a Download Folder for Horizon FLEX Virtual Machine Packages,” on page 15 and “Configure the IIS SSL Server Certificate for the Horizon FLEX Server,” on page 16.

**Procedure**

1. If the source virtual machine is running, shut it down.
2. In Fusion Pro or Workstation Pro, navigate to the source virtual machine.
3. Select **File > Export to TAR** and export the source virtual machine package to a TAR file.
   
   Remove any spaces from the TAR file name. Removing spaces from the file name can make it easier to connect to the download URL for the virtual machine.
4. Export the TAR file to your Horizon FLEX virtual machine packages download folder.

**What to do next**

Register the source virtual machine with the Horizon FLEX Policy Server. See “Register a Source Virtual Machine with the Horizon FLEX Policy Server,” on page 37.

Register a Source Virtual Machine with the Horizon FLEX Policy Server

You must register a source virtual machine with the Horizon FLEX Policy Server as a Horizon FLEX image before you can distribute the virtual machine to end users.

**Prerequisites**


- Verify that your Horizon FLEX virtual machine packages download directory is set up properly. See “Create a Download Folder for Horizon FLEX Virtual Machine Packages,” on page 15 and “Configure the IIS SSL Server Certificate for the Horizon FLEX Server,” on page 16.

- Verify that restrictions are already set in the source virtual machine’s configuration (`.vmx`) file. If you select a virtual machine that does not have restrictions set, the Horizon FLEX Policy Server rejects the `.vmx` file as invalid. For information about setting restrictions in a virtual machine, see “Create a Source Virtual Machine in Fusion Pro,” on page 32.

**Procedure**

1. If the source virtual machine is on a Mac, perform these steps.
   
   a. Find the virtual machine package (`.vmwarevm`) file for the virtual machine, right-click the file name, and select **Show Package Content**.
   
   b. Copy the virtual machine configuration (`.vmx`) file to a location that is accessible to the Horizon FLEX server.
2 Start the Horizon FLEX Admin Console.
   a In a Web browser, enter `https://WebManagerServer:7443/rvm`, where `WebManagerServer` is the DNS name or IP address of the host where the Mirage Web Manager is installed.
   b Enter the user name and password of a domain account that has access to Mirage.
   c Click Login.
3 Click Images in the left navigation panel.
4 Click the New (+) button.
5 Click Select next to the Select Image File text box and browse to the virtual machine configuration (.vmx) file for the source virtual machine.
6 Type a user-friendly name for the Horizon FLEX virtual machine file in the Image Name text box.
   For example: Windows 7 VM
7 (Optional) Type a description of the Horizon FLEX virtual machine in the Description text box.
8 (Optional) Click the Change button next to Icon and upload an icon for the Horizon FLEX virtual machine.
   Uploaded icons must be PNG (.png) files.
9 (Optional) In the Image URL text box type the fully qualified path of the TAR file that contains the source virtual machine package.
   End users will download the Horizon FLEX virtual machine from this URL. The URL format is `http://server:port/download_directory/filename.tar`, where `server` is the hostname or IP address of the server where you stored the TAR file, `port` is the port number on the server, `download_folder` is the name of the Horizon FLEX virtual machine download folder that contains the TAR file, and `filename.tar` is the name of the TAR file that contains the source virtual machine package. The URL can start with either http or https.
   For example: `https://flexserver.demo.local:7443/flexdownloads/windows7vm.tar`
10 (Optional) Type text in the Disclaimer (Optional) text box.
   If you do not specify any text, the Horizon FLEX Client does not display disclaimer text when a user downloads the Horizon FLEX virtual machine.
11 Click OK to register the source virtual machine as a Horizon FLEX image.
12 (Optional) Type the image URL in a Web browser to verify the URL.
   For example: `https://flexserver.demo.local:7443/flexdownloads/windows7vm.tar`
   You should be prompted to save the file. If you receive a permissions error, you might need to adjust the NTFS permissions for the download folder.

What to do next
Add policies to the Horizon FLEX image. See “Configure a General Policy for a Horizon FLEX Image,” on page 39.

Creating Policies and Entitlements
You use policies to set an expiration date and control the features in virtual machine instances created from a Horizon FLEX image. You use entitlements so that specific users and groups can create virtual machine instances from a particular Horizon FLEX image.

You associate a policy with each entitlement that you create. This policy defines the default restriction settings for the virtual machine instances that are created from the Horizon FLEX image in the entitlement.
You can include the same Horizon FLEX image in multiple entitlements, and you can associate each entitlement with a different policy. The same user can be a member of multiple entitlements.

When a virtual machine instance is created, the policies associated with entitlements determine the instance’s initial restrictions. As an administrator, you can change the restriction settings for a particular virtual machine instance. Instance-specific restrictions act as the restrictions for a specific user and virtual machine combination. For information about editing restrictions for virtual machines, see “Manage Horizon FLEX Virtual Machines,” on page 47.

### Configure a General Policy for a Horizon FLEX Image

You configure general policies to set an expiration date and control the features in virtual machine instances created from a Horizon FLEX image.

**IMPORTANT** If the copy-and-paste, drag-and-drop, and folder sharing settings are enabled in the source virtual machine, you can configure a policy to enable or disable these features when users download an instance of the virtual machine. If these features are disabled in the source virtual machine, you cannot override the virtual machine settings by enabling the features in a policy.

You select the policy to assign to a Horizon FLEX image when you entitle the image to users. You can use the same policy in multiple entitlements.

**Procedure**

1. Start the Horizon FLEX Admin Console.
   
   a. In a Web browser, enter `https://WebManagerServer:7443/rvm`, where `WebManagerServer` is the DNS name or IP address of the host where the Mirage Web Manager is installed.
   
   b. Enter the user name and password of a domain account that has access to Mirage.
   
   c. Click Login.

2. Click Policies in the left navigation pane.

3. Click the General tab to add a policy, or select an existing policy and click Edit to modify it.

4. Type a name for the policy in the Policy Name text box.

5. (Optional) Type a description for the policy in the Description text box.

6. In General Restrictions, configure virtual machine restrictions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expiration date</td>
<td>Use the calendar widget to set an expiration date for the virtual machine.</td>
</tr>
<tr>
<td>Copy and Paste operations</td>
<td>Specify whether to allow copy-and-paste operations in the virtual machine. This policy controls copy-and-paste operations between the virtual machine guest and host. It does not control copy-and-paste operations in the virtual machine.</td>
</tr>
<tr>
<td>Drag and Drop operations</td>
<td>Specify whether to allow drag-and-drop operations in the virtual machine. This policy controls drag-and-drop operations between the virtual machine guest and host. It does not control drag-and-drop operations in the virtual machine.</td>
</tr>
<tr>
<td>Folder Sharing settings</td>
<td>Specify whether to allow using shared folders in the virtual machine guest operating system if the administrator has configured shared folders in the virtual machine.</td>
</tr>
<tr>
<td>Change memory and CPU settings</td>
<td>Specify whether to allow users to change the memory and CPU settings of the virtual machine.</td>
</tr>
<tr>
<td>Require the user to change the power on passphrase when moving or copying the virtual machine</td>
<td>Specify whether to require users to change the encryption password if they move or copy the virtual machine.</td>
</tr>
</tbody>
</table>
### Configure a USB Device Policy for a Horizon FLEX Image

You configure policies to control whether USB devices can be used on virtual machines created from a Horizon FLEX image.

**IMPORTANT** If the USB device controller is present in the source virtual machine, you can configure a policy to enable or disable this feature when users download an instance of the virtual machine. If this feature is disabled in the source virtual machine, you cannot override the virtual machine settings by enabling this feature in a policy.

**Procedure**

1. Start the Horizon FLEX Admin Console.
   - a. In a Web browser, enter `https://WebManagerServer:7443/rvm`, where `WebManagerServer` is the DNS name or IP address of the host where the Mirage Web Manager is installed.
   - b. Enter the user name and password of a domain account that has access to Mirage.
   - c. Click **Login**.
2. Click **Policies** in the left navigation pane.
3 Click the Device Control tab to add a new device policy.

4 Select the Global Use of USB devices drop-down menu to set whether the policy will allow all USB devices or block all USB devices on the virtual machine.

All the USB device classes are dimmed and cannot be changed. See “Configure a Custom USB Device Policy for a Horizon FLEX Image,” on page 41 to create a custom policy where specific USB device classes are allowed.

5 Click OK to save the policy.

The new or updated policy appears in the policy list.

**What to do next**

Entitle the Horizon FLEX virtual machine. See “Entitle a Horizon FLEX Image,” on page 43.

### Configure a Custom USB Device Policy for a Horizon FLEX Image

You can configure custom device policies to control whether specific types of USB devices can be used on virtual machines created from a Horizon FLEX image.

**IMPORTANT** If the USB device controller is present in the source virtual machine, you can configure a policy to enable or disable this feature when users download an instance of the virtual machine. If this feature is disabled in the source virtual machine, you cannot override the virtual machine settings by enabling this feature in a policy.

**Procedure**

1 Start the Horizon FLEX Admin Console.

   a In a Web browser, enter https://WebManagerServer:7443/rvm, where WebManagerServer is the DNS name or IP address of the host where the Mirage Web Manager is installed.

   b Enter the user name and password of a domain account that has access to Mirage.

   c Click Login.

2 Click Policies in the left navigation pane.

3 Click the Device Control tab to add a new device policy.

4 Set the Global Use of USB devices drop-down menu to Custom to allow or block specific classes of USB devices on the virtual machine.

The text boxes for the class of USB devices appear, giving you the opportunity to allow or block specific classes.

5 Select the USB classes to allow or block on the virtual machine.

**Table 4-1. USB Device Types**

<table>
<thead>
<tr>
<th>USB Class</th>
<th>Base Class</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio</td>
<td>01h</td>
<td>USB sound card</td>
</tr>
<tr>
<td>Communication and CDC Device</td>
<td>02h</td>
<td>USB network adapter, RS-232 serial devices</td>
</tr>
<tr>
<td>Physical</td>
<td>05h</td>
<td>Joystick</td>
</tr>
<tr>
<td>Image</td>
<td>06h</td>
<td>USB camera, USB scanner, webcam</td>
</tr>
<tr>
<td>Printer</td>
<td>07h</td>
<td>USB printer</td>
</tr>
<tr>
<td>Mass Storage</td>
<td>08h</td>
<td>USB disk</td>
</tr>
<tr>
<td>Smart Card</td>
<td>0Bh</td>
<td>USB smart card reader</td>
</tr>
<tr>
<td>Content Security</td>
<td>0Dh</td>
<td>Fingerprint reader</td>
</tr>
</tbody>
</table>
Table 4-1. USB Device Types (Continued)

<table>
<thead>
<tr>
<th>USB Class</th>
<th>Base Class</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video</td>
<td>0Eh</td>
<td>Webcam</td>
</tr>
<tr>
<td>Wireless Controller</td>
<td>E0h</td>
<td>Bluetooth adapter, Microsoft RNDIS</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>EFh</td>
<td>Select the Miscellaneous option to allow or block USB devices not covered in the previous classes. See Table 4-2 for USB classes that require the Miscellaneous setting.</td>
</tr>
</tbody>
</table>

Table 4-2. Miscellaneous USB Device Classes

<table>
<thead>
<tr>
<th>USB Class</th>
<th>Base Class</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Human Interface Device (HID)</td>
<td>03h</td>
<td>USB keyboard, USB joystick, USB mouse</td>
</tr>
<tr>
<td>Hub</td>
<td>09h</td>
<td>USB hub</td>
</tr>
<tr>
<td>Personal Healthcare</td>
<td>0Fh</td>
<td>Pulse monitor (watch)</td>
</tr>
<tr>
<td>Diagnostic Device</td>
<td>DCh</td>
<td>USB compliance testing device</td>
</tr>
<tr>
<td>Application-specific</td>
<td>FEh</td>
<td>IrDA Bridge, Test and Measurement Class (USBTMC), USB Device Firmware Upgrade (DFU)</td>
</tr>
</tbody>
</table>

6 Optionally, you can configure the device policy to allow specific USB devices.

   a Under the **Allow the virtual machine to use the following USB devices** text box, click **Add**.
   
   b Enter the name of the USB device in the **Name** text box.
   
   c Enter the vendor ID as a hex value in the **Vendor ID** text box.
   
   d Enter the product ID as a hex value in the **Product ID** text box.
   
   e Click **Add** and click **Update**.
   
   To obtain the USB device information on a Windows machine, click **System Tools** and then select **Device Manager**. To obtain USB device information on a Mac, click the **Apple** icon, select **About the Mac**, select **System Report**, then select **USB** and click the device item.

7 Click **OK** to save the policy.

The new or updated policy appears in the policy list.

**What to do next**

Entitle the Horizon FLEX virtual machine. See “Entitle a Horizon FLEX Image,” on page 43.

**Update a Policy for a Deployed Horizon FLEX Image**

After a Horizon FLEX image has been deployed to users, you can update policies that apply to existing virtual machine instances.

**IMPORTANT** If you edit an existing policy by using the **Policies** button in the left navigation pane, the edit applies only to new users. The edited policy does not apply to existing users with deployed virtual machine instances. For example, in a scenario where the original policy does not restrict the user from creating multiple copies of the virtual machine, if you edit the policy to add this restriction, it would not apply to existing virtual machines. If a user has a virtual machine covered by the original policy, that user could still make copies of that virtual machine. If that user downloads a second virtual machine covered by the edited policy, the user would be restricted from copying that second virtual machine.
Procedure

1. Start the Horizon FLEX Admin Console.
   a. In a Web browser, enter https://WebManagerServer:7443/rvm, where WebManagerServer is the DNS name or IP address of the host where the Mirage Web Manager is installed.
   b. Enter the user name and password of a domain account that has access to Mirage.
   c. Click Login.

2. Click Virtual Machines in the left navigation pane.

3. Select the virtual machine.

4. Click Edit.

5. Update the policy for the virtual machine and click OK when complete.

What to do next
See “Configure a General Policy for a Horizon FLEX Image,” on page 39 and “Configure a USB Device Policy for a Horizon FLEX Image,” on page 40 for more information.

Entitle a Horizon FLEX Image

You use entitlements to allow specific users and groups to download and use virtual machine instances from a particular Horizon FLEX image.

Users can download any Horizon FLEX virtual machine to which they are entitled. Users need to enter their Active Directory credentials before they can register and use a Horizon FLEX virtual machine for the first time. Users can log in to the Horizon FLEX server and download the virtual machine. Or they can copy the Horizon FLEX virtual machine from a USB and enter the Active Directory credentials when the virtual machine first boots.

Prerequisites
- Verify that the appropriate Active Directory users and groups are synchronized in the Horizon FLEX database. See “Configure Active Directory Settings,” on page 16.
- Register the source virtual machine with the Horizon FLEX Policy Server. See “Register a Source Virtual Machine with the Horizon FLEX Policy Server,” on page 37.
- Configure a policy for the Horizon FLEX image. See “Configure a General Policy for a Horizon FLEX Image,” on page 39.

Procedure

1. Start the Horizon FLEX Admin Console.
   a. In a Web browser, enter https://WebManagerServer:7443/rvm, where WebManagerServer is the DNS name or IP address of the host where the Mirage Web Manager is installed.
   b. Enter the user name and password of a domain account that has access to Mirage.
   c. Click Login.

2. Click Entitlements in the left pane.

3. Click the New (+) button to create an entitlement, select an existing entitlement and click Edit to modify it, or select an existing entitlement and click Duplicate to duplicate it.
4 Create the entitlement name and assign it to a Horizon FLEX image.
   a Enter a name for the entitlement in the **Entitlement Name** text box.
   b Select a Horizon FLEX image to add to the entitlement.
      You can use the search field to filter the list of Horizon FLEX images.
      If you duplicate an existing entitlement, you must rename the duplicate entitlement before saving it.
      When you select the Horizon FLEX image, the download URL for the image is automatically populated in the **Download URL** text box.
   c In the **Download URL** text box, change the URL that the client uses to download the Horizon FLEX image.
   d Click **Next**.

5 Select the Active Directory users and groups to include in the entitlement.
   a Use the search field to find and select users and groups to add to the entitlement.
      New active Directory users and groups can take up to 15 minutes to appear in search results.
   b Click **Add** to add a user or group to the Entitlement Members list.
      You can use the **Remove** or **Clear All** buttons to manage the list of members.
   c Click **Next**.

6 Select a policy for the entitlement and click **Next**.
   You can use the search field to filter the list of policies and the **Clear Filter** and **Show Filter** buttons to manage your searches.

7 (Optional) To use a virtual machine naming pattern, select **Use machine name configuration** and configure the naming pattern.
   a Enter the machine name pattern to use in the **Machine Name Pattern** text box.
      To ensure that each virtual machine receives a different name and can join the domain, include the `{username}` placeholder. This placeholder is replaced by the individual user's name when the user downloads the virtual machine. You can also create a running number pattern using the `{n}` placeholder to increment virtual machine numbers with user names.
      For more information, see “Create a Virtual Machine Name Pattern,” on page 45.
   b Select a domain name from the **Domain name** drop-down menu.
   c Enter an OU in the **Organizational Unit** text box.
      For example: **OU=hr1, OU=hr, OU=flex, DC=ws, DC=test, DC=com**
8 (Optional) If you installed the Mirage client in the virtual machine, select whether to manage the virtual machine with Mirage.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use VMware Mirage for disaster recovery and Image management scenarios</strong></td>
<td>Select this option to select a CVD policy, a base layer, an application layer, and other configurations. The Mirage server automatically creates a CVD for virtual machines that the end user downloads. Mirage periodically synchronizes end-user data into the data center based on the selected Mirage policy. In the main Mirage Management Console, you can use this data to restore the CVD or access files on the virtual machine by using the Mirage File Portal. The Mirage server also automatically deploys base and application layers to the virtual machine after it has been provisioned for image compliance and remote application delivery.</td>
</tr>
<tr>
<td><strong>Use VMware Mirage for disaster recovery scenarios</strong></td>
<td>Select this option to select a CVD policy. The Mirage server creates a CVD for virtual machines that the end user downloads. You can use this data to restore the CVD or access files on the virtual machine by using the Mirage File Portal in the main Mirage Management Console.</td>
</tr>
<tr>
<td><strong>Do not use VMware Mirage to manage the virtual machines</strong></td>
<td>Select this option to opt out of managing the virtual machine with Mirage.</td>
</tr>
</tbody>
</table>

If you delete a virtual machine in which the Mirage client is installed, the Mirage server archives the CVD of the deleted virtual machine.

9 Click **Next** and review the settings of the entitlement.

10 Click **Finish** to save the entitlement, or click **Back** to return to the previous page and edit the entitlement.

**Create a Virtual Machine Name Pattern**

When entitling a Horizon FLEX image, you can create a virtual machine name pattern so that when virtual machines are created for the same user entitlement, Horizon FLEX creates unique virtual machine names.

The virtual machine name pattern must include the `{username}` or `{n}` parameters. The `{n}` parameter enables the creation of a running number pattern to add incremental numbers to virtual machine names. These patterns are valid:

- VM-{username}
- VM-{n}

These patterns are not valid.

- VM-{username}-{username}
- VM-{username}-{n}
- VM-{n}-{n}

The machine name is limited to 15 characters. If a machine name is longer than 15 characters, only the first 15 characters are used. For example, if the pattern is VM-1234567890-{username} and the user name is Jack, the machine name is trimmed to VM-123456789-J.

To ensure that each virtual machine receives a different name and can join the domain, it must include the `{username}` or `{n}` placeholders. The `{username}` placeholder is replaced by the individual user’s name when the user downloads the virtual machine. For `{n}`, the Active Directory is searched for computers with names that match the pattern. If no names match the pattern, the running number value is 1. Otherwise, the value for the next running number is the successor number of the maximum number between all names that match the pattern.
For example, one virtual machine might be entitled to user1 and the machine name pattern might be set as VM-username- n. When user1 downloads the virtual machine, Active Directory is searched to determine whether a machine name matches the name pattern, such as VM-user1-x, where x is the assigned number. If the maximum mapping number is 25, where the virtual machine name is VM-user1-25, this machine name is set as VM-user1-26. If no virtual machine matches the pattern, Horizon FLEX sets the machine as VM-user1-1.

You can entitle more than one virtual machine to the same user. For example, you can entitle three virtual machines to user1. When user1 downloads the virtual machines, the virtual machine name is changed to vm-x-user1. The assigned virtual machine number is not incremented for each user name but is based on when the virtual machine was registered.

For example, user1 might have three virtual machine names vm-10-user1, vm-26-user1 and vm-39-user1, depending on which other virtual machines were entitled to other users and when user1 downloaded each virtual machine. The incremented number is used only for tracking by the Horizon FLEX administrator. The client user does not see the incremented number.

Create a URI to Deploy a Horizon FLEX Virtual Machine

You can deploy a Horizon FLEX virtual machine by creating a uniform resource identifier (URI). Using a URI, you can create an email that contains a link that the end user can click to connect to a server and download a Horizon FLEX virtual machine.

Prerequisites
- Verify that the Horizon FLEX client is installed on the end user system.
- Give the end user a password for the server and the encryption password for the virtual machine.

Procedure
1. Construct a URI for the end user.
   A URI has the following structure:
   ```
   vmware-rvm://username@myserver.com:7443
   ```
   `username` is the user's login name and `myserver.com` is the host name of the server. You must include `vmware-rvm://` and `:7443` in the server address. Do not include http or https in the server address.

2. Type link text in an email and enter hyperlink information for the URI.
   You can use any email system to send the link. However, because the format of the URI is not recognized as a standard URL, you must manually enter the hyperlink information.

3. Create an email for the user and enter some link text.
   For example: Your Horizon FLEX virtual machine

4. Select the link text, right-click the selected text, and select Hyperlink.

5. Select Link to: Existing File or Web Page.

6. Enter the URI in the Address text box.
   For example: `vmware-rvm://johndoe@yourserver.com:7443`
   The link is now active.

7. Click OK.

8. Send the email to the user.

When the user clicks the link in the email, the user's Horizon FLEX Client starts and the server connection dialog box opens. The server and user name text boxes are prepopulated with the values that you specified in the URI. The user enters a password and connects to the server to download a virtual machine.
Managing Horizon FLEX Virtual Machines

You can manage deployed Horizon FLEX virtual machines by performing operations such as Edit, Lockout, Reactivate, Wipe, Archive, or Delete.

Manage Horizon FLEX Virtual Machines

Once Horizon FLEX virtual machines are deployed, you can manage them by performing different operations. You can view the inventory of deployed Horizon FLEX virtual machines in the Horizon FLEX Admin Console.

You can use the Search text box to filter the virtual machine list and the sortable column headings to find a specific virtual machine. Use the column heading drop-down menu to select the columns to view or hide.

When you select a virtual machine in the list, you can expand the Properties window at the bottom of the page to view general settings for the virtual machine and policies applied to the virtual machine.

Procedure

1. Start the Horizon FLEX Admin Console.
   a. In a Web browser, enter https://WebManagerServer:7443/rvm, where WebManagerServer is the DNS name or IP address of the host where the Mirage Web Manager is installed.
   b. Enter the user name and password of a domain account that has access to Mirage.
   c. Click Login.
2. Click Virtual Machines in the left navigation pane.
   The inventory of deployed Horizon FLEX virtual machines appears on the Virtual Machines page.
3. To manage a specific virtual machine, select the virtual machine in the list.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>Select a virtual machine and click Edit to change the policies assigned to this virtual machine.</td>
</tr>
<tr>
<td>Lockout</td>
<td>Select a virtual machine and click Lockout to revoke user access to the specific virtual machine.</td>
</tr>
<tr>
<td>Reactivate</td>
<td>Select an expired or locked-out virtual machine and click Reactivate to reset the virtual machine.</td>
</tr>
<tr>
<td>Wipe</td>
<td>Select a virtual machine and click Wipe to delete it from the file system.</td>
</tr>
</tbody>
</table>
Select a virtual machine and click **Archive** to disable the virtual machine for use and keep an offline record of the virtual machine. Select the **Display archived instances** box at the bottom of the Virtual Machines page to view virtual machines that have been archived. You can click **Reactivate** to enable an archived virtual machine.

Select an archived virtual machine and click **Delete**. You cannot delete a virtual machine that has any other status than Archived.

To determine the actions that you can take for a virtual machine, view the virtual machine status in the Status column.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>The virtual machine is in use, has contacted the server, and has not expired.</td>
</tr>
<tr>
<td>Inactive</td>
<td>The Horizon FLEX Client that the user used to open the virtual machine has failed to contact the server for longer than the offline working policy period.</td>
</tr>
<tr>
<td>Expired</td>
<td>The expiration date has been reached and the virtual machine has been turned off.</td>
</tr>
<tr>
<td>Pending Expired</td>
<td>The server is waiting for confirmation from the Horizon FLEX Client that the virtual machine is expired.</td>
</tr>
<tr>
<td>Locked Out</td>
<td>An administrator has locked out the user of the virtual machine.</td>
</tr>
<tr>
<td>Pending Lockout</td>
<td>A lockout has been initiated. The status remains Pending until the Horizon FLEX Client verifies that the virtual machine has been locked out.</td>
</tr>
<tr>
<td>Pending Reactivate</td>
<td>The server is waiting for confirmation from the Horizon FLEX Client that the virtual machine is reactivated.</td>
</tr>
<tr>
<td>Downloading</td>
<td>The user is downloading the virtual machine.</td>
</tr>
<tr>
<td>Download Cancelled</td>
<td>The user has canceled the download.</td>
</tr>
<tr>
<td>Download Paused</td>
<td>The user has paused the download.</td>
</tr>
<tr>
<td>Domain Join Fail</td>
<td>The virtual machine failed to join a domain. The most common reason why a virtual machine might fail to join a domain is that the object already exists in Active Directory. In this case, check the offline domain join log, which is maintained by the operating system, to determine how to solve the failure.</td>
</tr>
<tr>
<td>User Deleted</td>
<td>The user has deleted the VM on the client.</td>
</tr>
<tr>
<td>Wiped</td>
<td>The virtual machine has been wiped by the administrator and removed from the user's system.</td>
</tr>
<tr>
<td>Pending Wipe</td>
<td>The server is waiting for confirmation from the Horizon FLEX Client that the virtual machine has been removed from the user's system.</td>
</tr>
<tr>
<td>Archived</td>
<td>The virtual machine has been archived.</td>
</tr>
</tbody>
</table>

**Note:** You must select the **Display archived instances** check box to view archived virtual machines.
You can perform maintenance operations on the Horizon FLEX system, including upgrading from previous Horizon FLEX versions.

This chapter includes the following topics:

- “Upgrade from Previous Horizon FLEX Versions,” on page 49
- “Horizon FLEX System Logs,” on page 50

Upgrade from Previous Horizon FLEX Versions

You can upgrade the Horizon FLEX system from earlier Horizon FLEX versions.

Prerequisites

- All Mirage servers are shut down.
- All deployed Horizon FLEX virtual machines are shut down.

Procedure

1. Download the Horizon FLEX Server and Horizon FLEX Client installation files for the upgrade version.
2. Upgrade the Horizon FLEX Server component.
   a. To upgrade the Mirage Management Server, double-click on the mirage.management.server.64x.buildnumber.msi file in the server folder.
      By default, the configuration settings you selected during the initial installation are applied. You can change the configuration settings during the upgrade process.
   b. To upgrade the Mirage server, double-click on the mirage.server.64x.buildnumber.msi file.
      By default, the configuration settings you selected during the initial installation are applied. You can change the configuration settings during the upgrade process.
   c. To upgrade the Mirage Web Manager (Web Management Console), double-click on the mirage.WebManagement.console.x64.buildnumber.msi file in the WebManagement folder.
      Continue with no change.
   d. If you use Mirage to manage your Windows virtual machines, follow the instructions for upgrading from the previous Mirage version in the VMware Mirage Administrator’s Guide.
3 Upgrade all Horizon FLEX clients to the version that is compatible with the upgraded Horizon FLEX Server.

- Provide your end users with the installer file for the Fusion Pro or Workstation Player upgrade version, or instruct them to download the software from the VMware Web site.
- Upgrade the Horizon FLEX Clients by using a mass deployment.

**What to do next**

For complete Mirage upgrade instructions, see the VMware Mirage documentation at [https://www.vmware.com/support/pubs/mirage_pubs.html](https://www.vmware.com/support/pubs/mirage_pubs.html).

**Note** Do not select the Create new storage areas when upgrading the Mirage Management Server. If you select this option and enter the path to the original storage area, your entire Mirage installation, including base layer, app layer, CVD data, and so on, are deleted and become irretrievable if a backup is unavailable.

See “Installing the Horizon FLEX Client for End Users,” on page 18 for information on using a mass deployment to provide the Horizon FLEX Client to end users.

**Horizon FLEX System Logs**

Horizon FLEX log files can be used for troubleshooting system issues.

Horizon FLEX system logs are available in the following locations:

- **Web App log file**
  
  C:\ProgramData\Wanova Mirage\rvm\logs\webapp.log

- **Horizon FLEX server logs**
  
  C:\Program Files\Wanova\Mirage Management Server\logs
  
  The most important log file is the mgmtservice.log file.

- **Horizon FLEX uses the Microsoft offline domain join feature. The offline domain join log file is at:**
  
  C:\Windows\debug\NetSetup.LOG
Index

A
Active Directory 16, 36, 43
architecture 8
archiving virtual machines 47

C
certificates
  internal root CA 27, 28
  self-signed 15
certificates, self-signed 24, 25
certificates, setting up 15
components 7
configuring, Active Directory settings 16
copy and paste 39
creating Horizon FLEX VMs 31
custom device control settings 41

D
deleting virtual machines 47
deploying Horizon FLEX VMs 31
deployment overview 31
device control settings 40
domain join 36
download folder 15
drag and drop 39

E
editing virtual machines 47
e-mail link 46
encryption settings 32
entitlements 43
entitlements and policies 38
EULA 37
expiration date 39
expired certificates 24
exporting certificates 22, 23

F
folder sharing 39

G
glossary 5
guest operating systems 12

H
Horizon FLEX terminology 7
Horizon FLEX Admin Console 17
Horizon FLEX Client, installing for end users 18
Horizon FLEX system logs 50
Horizon FLEX system server requirements 10
Horizon FLEX VM deployment 31
host operating systems 12

I
IIS virtual directory 16
image URL 37
installation overview 13
installing Fusion Pro, mass deployment package 18
installing Horizon FLEX Client software for end users 18
internal CA certificates 27, 28
introduction 7

K
Keychain Access 22, 28

L
locking out virtual machines 47

M
Mac certificates 22, 28
machine name configuration 43
maintaining the Horizon FLEX system 49
mass deployment feature for Fusion Pro 18
memory and CPU settings 39
Mirage 8, 14
Mirage client 35

N
network requirements 11

O
organizational units 16

P
PEM format 22, 23
policies 39
policies and entitlements 38
policy server 37
policy updates 42

R
reactivating virtual machines 47
restriction settings 32
RVM Setup Service 36

S
self-signed certificates 24, 25
setting up Horizon FLEX server certificate 15
source virtual machines 31–33, 37
status values 47
system requirements, Horizon FLEX 10

T
TAR file 37
trusted certificates list 21, 23

U
unattended Workstation Player installation 19
updating a policy 42
upgrading Horizon FLEX version 49
URI format 46
USB custom device control settings 41
USB device control settings 40

V
virtual machine packages 37
virtual machine name pattern 45
VM packages 37
VMware RVM Setup Service 36
VMware Tools 36

W
Windows certificates 23–25, 27
wiping virtual machines 47
Workstation Player installation package 18
Workstation Player installation properties 19